Ready for Reading, Technology Tools in the Early Elementary Classroom Day 2

Good Morning
Day 3
Communication &
Internet

The use of technology has evolved
considerably when it comes to student
writing and the writing process. It seems
as if the glory days of using technology to
just publish finished works are over. The
allure of making something look good
seems to have been replaced by using
the technology to facilitate creativity
and revision of written work. Technology
provides an easy platform for editing and
stimulating new thought about what
students are writing. With the use of
blogs, wikis and other online publishing tools
Q students are now seeing the value in writing and
writing for an audience.
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Why Use the Internet?

Before we can begin to explore the effective uses of the
Internet in classroom instruction, we must first ask
ourselves, "Why should teachers use the Internet in the
instruction of students?” This question has been
investigated and reported on exhaustedly for the past
decade. Even though the answer continues fo evolve as
educators become more accepting of the medium, we find
that that the core of the answer to that question is, "It's
an unlimited resource.” It breaks the bonds of reliance on
the printed text. We are no longer solely dependent on
what the textbook companies have to offer. Educators
and students have access to an unlimited library of information and are only bound by
their own creativity as to how fo use it.

It is true that the Internet and the amount of information available o us can be
categorized as a sort of information explosion, or taking “a drink from a fire hose."
However, this has been a technological evolutionary process. Before the Internet, we
had other information delivery systems. Let's look at the history of the encyclopedia as
an example. In 1768, Encyclopedia Britannica published its first Encyclopedia. It had 32
volumes. In 1989, they published the first encyclopedia on CD-ROM. Today it's online.
The print version is still available if you're ready to fork over $1,396.60 for the
complete set. Or you can pick-up the entire set plus animations, movies, color pictures,
animated maps and you can keyword search it, all for under $50 dollars at your local
Wal-Mart store. Another plus for the CD-ROM is that it will fit in your pocket.

This example and its timeline are important. In 1768, we have the first commercially
available printed encyclopedia. Two hundred and twenty one years later, we have it
printed onto a small, round plastic disc. Just five years later, in 1994, much of it was
made available free online for anyone with a computer and modem. This is a significant
shift in how we acquire information in a very short period of time. It took 221 years to
evolve from print to electronic publishing, but only 5 years to further evolve our system
of information delivery. I use this example because it highlights the evolution of the
delivery system, which in some way dictates the use of that system.

As I continued to explore the initial question, (Why should teachers use the Internet in
the instruction of students?), I began to realize that the answer was being dictated to
us by the commercially driven market place. It seems our question is no longer valid. As
more and more information becomes cheaply available on the World Wide Web, our
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question clearly must change. Now it sounds more like, "When will teachers begin to use
the Internet in the instruction of students?” And "What are the effective uses of the
Internet in classroom instruction?” So, once again, we have found ourselves studying an
education issue long enough for the question to evolve away right before are very eyes.
The answer now seems much simpler than it did a decade ago. The Internet can provide
invaluable resources which cannot be delivered using other technologies, books, or
school resources.

Finding and Using Internet Resources
What is in it for my classroom and me?

e Lesson plans e Other teachers
e Printable resources e Other classes
e Online software e Virtual tours

e Online activities e Newsletters

e Authors e Professional

o Experts information

e Audio and video clips
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The Internet as a Tool for Educators

The Internet has become a major medium of communication and information. For
teachers the Internet is a particularly valuable tool. There is a lot available for
teachers that they can grab, adapt, and use which will make their work easier and
richer. The Infternet exemplifies the expression that many hands make light work. The
key to using the Internet productively is to become a savvy, selective surfer of the
Web and eventually to contribute back to the education community by contributing your
ideas and lessons.

How do I Locate Great Stuff Fast?
Use a Search Utility!

Directories-_Libraries on the Web!
The Browse-Search
Directories are designed to be browsed. The web links included in a directory are
selected and organized by people. When you search a directory, you search only the
material that the directory knows about. Directories often provide some level of review
for the material included.

Yahoo
www.yahoo.com
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Search Engines

Ask for What You Need!
Spiders/Robots who do the looking for you. These are programs that try to match the
keyword or information a user supplies to a web site. Each does it a little differently.
Some search the text of web sites. Some search only the titles and some search the
text that users do not see. Search engines do not determine whether it is a good match
or not.

Google

www.google.com

"Currently the largest search engine, indexing billions of web pages. It is a full-text
index that searches the entire HTML file."

Altavista

www.altavista.com

"First, AltaVista checks the words you enter against a massive (half-million entry)
phrase dictionary to determine which words go together naturally, and automatically
treats them as phrases. In other words, if you enter George Bush or New York or
baseball bat, the system knows that those are not just random words, and hence looks
first for instances where those complete phrases appear on Web pages, and puts those
pages near the top of your list. For instance, DEC tulip (a computer card) is now
automatically recognized as a phrase; whereas before that query would have generated
lots of results related to flowers, now such a search gives you much more useful
results.”

http://www.altavista.com/sites/help/search/search help
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ASK

http://www.ask.com/

http://www.askforkids.com

This search tool uses something the others don't to return great links to you.
Instead of link popularity ranking they use something they call "Subject Specific
Popularity.” They determine who the experts in the field are that understand what
you are looking for and then derive the link ranking by reviewing what the have
linked to. Sound confusing? I'm confused and I just spent 20 minutes trying to
figure out how to explain it. I guess it boils down to trying to determine a trusted
source and give it more weight in the ranking. What ever they do, it works.

Meta Search Engines- Engines that search other engines

Your Own Personal Shopper
Meta search engines are programmed to search other search engines and return results
from those engines. Some allow users to choose the engines that are used in the search.
Others offer the capability to search for different types of material, date ranges, or
other languages for the search.

Dogpile

www.dogpile.com

"Dogpile searches four search engines at a time. Lists of results from four engines are
displayed on each page. If you do not get at least 10 documents matching your query,
Dogpile will automatically search the next four engines, and so, on until all are searched
or 10 matches are found.” Dogpile provides a directory and allows users to search for
images, audio, ftp files, and a variety of specialized searches by choosing from a drop
down menu in their regular search. Users can look for the Custom Search link on the
bottom of the home page to choose the search engines Dogpile should use to do the
search.

Mamma

www.mamma.com

"Mamma.com is a "Smart Meta Search Engine." When the user enters a query at the
Mamma.com website, Mamma's powerful proprietary technology simultaneously queries a
series of Search Engines and properly formats the words and syntax for each source
being probed. Mamma then creates a virtual database, organizes the results into a
uniform format, and presents them by relevance and source. In this manner, Mamma.com
provides the end user with a highly relevant and comprehensive set of search results.”
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Specialized Searches
Not all engines search for all types of materials. There is a term called the invisible web
that describes resources that are on the World Wide Web, but not picked up by search
engines. Material that is stored in databases frequently is not searched. Portable
document files (pdf) are not always picked up in searches. Audio and image files are not
necessarily picked up. Below is a list of specialized search engines that focus on material
on the invisible web.

Altavista Images
http://www.altavista.com/sites/search/simage

Altavista Video
http://www.altavista.com/sites/search/svideo

Altavista MP3/Audio
http://www.altavista.com/sites/search/saudio

Google Images
http://www.google.com/imghp?hl=en

Google File Search
http://www.google.com/advanced search

Federal Government Search
http://www.ed.gov/
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What strategies should use when I search?

Use More than One

No one search engine or directory is going Yo meet all your needs. Think about what you
are looking for and then try that term in several different search engines or
directories. There will be overlap in our results, but you should locate material more
quickly.

Learn How the Search Tool Works

When you are learning a new engine, look for a section labeled tips or information. Take
a moment to read how that engine or directory works and what special features it may
offer. Some engines cache pages so that even if the web page you are looking for is no
longer available, you can still see it. Some allow users to be notified is a page changes.

Broaden or Narrow Your Search

e Think synonyms. Most engines will not pull "amphibians * or "tadpole” when it is
searching for frogs.

e Engines often are very specific. Some distinguish between upper and lower case
letters. So “frog"” and “Frog" will produce different results. So if you are looking
for an exact title use capital letters. If you are not looking for a proper noun, do
not use capital letters.

Combine Terms

The more specific users can be with what they are searching for, the better their
results will be. Instead of using just one term in a keyword box, find out if the engine
you choose allows users to combine terms and in what way.

Combination Technique Example
Combine terms with "AND" Kindergarten+math
or "+" to cause search
engines to return results Kindergarten AND math

that have both terms but
not necessarily next to each

other
Exclude terms from a search Pre-k-school
using "NOT" or "-" Pre-k NOT school
Search for a phrase using "dramatic play”
quotation marks
Use an asterisk to pull all write*
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variations of a word

Use Advance Search Features

Look for advanced search functionality in a search engine. Often users will find the
option to choose the date of the material, the language, the type of material, the source
of the material, and so forth. In addition, advanced searches often provide help with
search syntax, which makes combining terms easier.

Go Straight to the Source

Sometimes the best way to locate information is not to use a search engine but to go
directly to a site that provides that information and search the site. Below are some
examples for web sites for early childhood educators.

Gayle's Preschool Rainbow
http://www.preschoolrainbow.org/

Preschool Express
http://www.preschoolexpress.com/

Pre-K Central
http://prek.dhs.orq/

Alphabet Soup
http://alphabet-soup.net/

Kinderart.Com
http://www.kinderart.com

A to Z Teacher Stuff
http://atozteacherstuff.com/lessonplans/Grade_K/
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Find web pages that have...
all these waords:
this exact wording or phrase:

one or more of these words:

But don't show pages that have...

any of these unwanted words:

Need more tools?
Results per page: 10 results
Language: any language
File type: any format
Search within a site or domain:
(e.g. youtube.com, .edu
&) Date. usage rights, numeric range. and more

Date: (how recent the page is} anytime

Google Advanced Search

Software Helper

Usage rights: not filtered by license -
Where your keywords show up:  anywhere in the page -
Region: any region -
MNumeric range:
SafeSearch: :E (:]ﬁ:w ?VWC‘)‘n
Advanced Search
To Open the Click on Advanced Search on www.google.com.
Advanced Search The top four fields in the blue box replace Boolean searches. So
Window instead of having to construct searches using the + or - symbols,

Google's Advanced Search fields performs those functions.

To Broaden a
Search

In the search field next to "with all of the words" type the word(s)
you wish to search for and then press Google Search.

Google will return pages with all the terms you list in the search
results.

Another option would be to put the main term in the top field and
then list possible additional terms in the field next to “with at
least one of the words".

In this case Google will look for the top term and include as many of
the other terms as possible in the search results.

To Narrow a Search

In the search field next to "with all of the words" type the word(s)
you wish to search for and then press Google Search.

In the field next to "without the words" type the words that should
be excluded from the search, then press Google Search.

To Search for a
Phrase

In the field next to "with the exact phrase” type the phrase you
wish to look for and then press Google Search.

Google will conduct a complete text search looking for the words in
the phrase.

Interpreting Search Results
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Viewing Missing Web
Pages

Google's search results include the title of the web page, the
description of the web page and the URL to link to it.

Google also keeps a copy of the web page for itself. If the
page is no longer available, click on cached next to the URL to
open and use Google's copy of the site.

Finding Similar Pages

If one of the results is exactly what you want, click on Similar
Pages, next to cached, o pull up other pages like the one you
selected.

Additional Advanced Search

Options

Choosing a Language

The Advanced Search will return pages in any language.
To restrict results to one language, click on the down arrow
next to that field and select the language.

Selecting File Format
Options

A powerful option in the advanced search is to restrict the
search to a specific file format or to exclude that format
from a search.

With the first down arrow next to the File Format field select
Only or Don't.

Then click the down arrow next to the second field to search
for a specific file format.

Selecting a Country

This will allow you to search content housed on servers in
specific countries. "American Revolution” in the UK

To Limit the Date

If you are searching for material and would like to limit the
results to only the most current or updated pages, use the
Date field.

The down arrow, next to the date field, allows users to limit
the search to a time frame for when the page was last
updated.

To Restrict a Search

The occurrences field allows users to tell Google where to look
for the terms listed in the search boxes

Using the Domain Feature

Using the domain features allows users to restrict a search to
specific web site or type of site. For example, limiting a search
to URL's that end in edu will return results that are identify
themselves as being a school.
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How to Save Graphics from the Internet

1. Find a graphic on the Internet that you would like to save.

2. Right click on the image you would like to save and select Save Image As. On the
Mac just click and hold on the graphic and choose "copy to disk”

3. Change to the appropriate drive. A file name should appear. Click Save.

The graphic was either saved with a .GIF or .JPG extension. In order to pull the graphic
into some Windows programs (ClarisWorks 4.0, Student Writing Center, Kid Pix Studio),
the file needs a .BMP extension. You must open the file in a paint program which allows
you to convert the graphic to a .BMP format. Paint Shop Pro is one example of such a
program. Conversion is unnecessary if your program will accept graphics with a .GIF or
JPG extension. ClarisWorks 5.0, Kid Pix Studio Deluxe, and HyperStudio will allow you
to use graphics with a .GIF and .JPG extension. The change is not necessary if you are
inserting the graphic into Microsoft Word.

4. Minimize Netscape.

5. Open Paint Shop Pro.

6. From the File menu, select Open.

7. Select the appropriate drive and click on the graphic you just saved. Click OK.
8. The graphic should appear on your screen.

9. Under the FILE menu, drag down to SAVE AS.

10. Change the List Files of Type box to .BMP - Windows Bitmap.

11. Click OK.

12. Look on the Title Bar. The graphic should now have a file name that ends in .BMP.
13. File, Exit.

You should be able to pull your graphic into other programs. This is a great way to
create a graphics folder for a theme or unit of study.

* You should get permission to use any graphics that you save or copy from the Internet
in order to comply with copyright laws.

How to Copy/Paste Graphics from the Internet

You must use Microsoft Internet Explorer in order to copy/paste graphics from the
Internet. Netscape will only let you SAVE the graphics--not copy and paste them.
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Open Microsoft Internet Explorer.

Locate the graphic you wish to copy.

Right click on the graphic (on a Mac just click and hold). A menu will appear.
Choose Copy.

A copy of the image is placed on the clipboard.

Open the document in which you wish to paste the image.

From the Edit Menu, choose Paste.

NS OhswnN =

Occasionally, using Internet Explorer to copy graphics from a PC results in a distorted
image. The colors don't always paste into a document as they appeared on the Internet.
In such cases, you should save the image from the Internet rather than copying and
pasting. You may then have to convert the graphic using Paint Shop Pro or some other
draw program to a .bmp format in order to use it in your program.

Copying and pasting is an easy way to get a quick graphic from the Internet. If you'd
like to create a graphics folder, you'll need to save the graphics from the Internet

rather than copying and pasting.

* You should get permission to use any graphics that you save or copy from the Internet
in order to comply with copyright laws.
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How to Copy/Paste Text from the Internet

Open Netscape or Internet Explorer.

Locate the text you wish to copy.

Highlight the text.

From the Edit Menu, choose Copy.

A copy of the text is placed on the clipboard.

Open the document into which you wish to paste the text.

Click to plant the cursor where you would like to paste the text.
From the Edit Menu, choose Paste.

NSO AN

Copying and pasting is an easy way to get text from the Internet. However, you should
be mindful of copyright laws and give credit to the Web page from which you took the
text.
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How to Cite Resources from the Internet

1. World Wide Web

Structure:

Author. Title of item. [Online] Available http://address/filename, date of document or download.
Example:

Schwartz, Robert. The Cold War Revisited: A Splintered USSR. [Online] Available
http://usa.coldwar.server.gov/index/cold.war/countries/former.soviet.block/, November 1, 1998.

2. Email/LISTSERVs

Structure:

Author of email message. Subject line of the message. [Online] Available email: Student@address.edu
from Author@address.edu, date of document or download.

Example:

Rule, Christopher. Nile River Research Project results. [Online] Available email:
student5@smallvillehigh.edu from ert@informns.k12.mn.us, October 2, 1998.

3. Images/6Graphics

Structure:

Description or title of image. [Online] Available http://address/filename, date of document or
download.

Example:

Butterfly. [Online Image] Available http://www.kidsdomain.com/holiday/spring/clip.html/ butterfly.gif,
October 23, 1998.

4. Sounds

Structure:

Description or title of sound. [Online Sound] Available http://address/file, date of document download.
Example:

Reflections on Apollo. [Online Sound] Available ftp://town.hall.org/radio/
IMS/NASA/100394_nasa_01_ITR.au, September 25, 1998.

5. Video Clips

Structure:

Description or title of video clip. [Online Video Clip] Available http://address/file, date of download.
Example:

Shoemaker-Levy Comet enters Jupiter's atmosphere and breaks up. [Online Video Clip] Available
ftp://ftp.cribxl.u-bordeaux.fr/astro/anim/s19/breakingup.mpg, September 5, 1998.
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A House for Hermit Crab

Notes

Instruction
Essential Question for Teachers:
How can I integrate technology into a traditional author study lesson?

Essential Question:

What is a hermit crab? What are some other ocean animals? How are
people like hermit crabs? What do you think Hermit Crab will do with
his next house?

Learning Goals:

Integrate listening, speaking, viewing, reading, and writing skills for
multiple purposes and in varied contexts. Examples include using more
than one of the language arts to create a story, write a poem or letter,
or to prepare and present a unit project on their community.

Describe the basic requirements for all living things to maintain their
existence. ( Key concepts: Needs of life-food, habitat, water, shelter,
air, light, minerals. Rea/-world contexts: Selected ecosystems, such as
an aquarium, rotting log, terrarium, backyard, local pond or wetland,
wood lot.)

Technology Connections:

Students will create a time line based on events in the story A House
for Hermit Crab. They will also create a graph showing how much they
will grow in their lifetime. In a center, students will make number
sentences in KidPix.

Preparation:
Save graphics from story in a folder on the computer. Make a timeline
template that students can use.

Procedure:

1. Read A House for Hermit Crab by Eric Carle. Have students listen
for the names of ocean animals in the book.

2. Next, give each student a word card. When each word is intfroduced
in the book, have that student bring his word up to the board and
put it in a pocket chart. The completed pocket chart should have
the month with the corresponding animal or plant. After you are
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finished, have students re-tell the story using the information in
the pocket chart.

. Time Line of Events a Whole Group Activity

4. Explain that students are going o make a time line that represents
what happened to Hermit Crab over a period of a year.

5. Using the information in the pocket chart, model creating a time line

on the computer with a scan converter or in a small group. Open

TimeLiner software and follow the directions to create your time

line. Have students give you the specific months and events.

Print your fime line in banner form and display it in the classroom.

Graphing Growth an Individual Activity

Ask students to tell you why Hermit Crab needed a different shell

(because he was growing). Ask them what happens to their clothes

as they grow (they get smaller).

9. Give students the My How You've Grown sheet and a measuring tape.
Allow them to work with a partner to measure their height in inches
and record it in the appropriate place.

10. Explain that students will need to take the sheet home with them
and fill in the other two sections with their parent's help.

11. When students bring the sheet back, have them use this
information to create a graph in The Graph Club, showing how much
they have grown. Demonstrate the procedure to the class on the
computer using a scan converter, before students create the graph
themselves. Use the directions fo create your graph.

12. What's your Shell Worth, Hermit Crab? A Center Activity

13. Create a center activity in KidPix in which students find the worth
of Hermit Crab's house.

14. Take pictures of the images in the book with a digital camera and
save to the hard drive of the computer.

15. Open up KidPix and choose Edit and Paste. Move it where you want
it fo go. Use the line tool fo separate the crabs on the paper. (If
the crab is oo small, copy it first into Word, resize it, then copy
and paste it into KidPix.)

16. Have a laminated copy of the Hermit Crab decoding chart next to
the computer.

17.Explain that students will be decorating Hermit Crab with the
buttons and bows tool in the KidPix Paintbrush. Depending on the
ability level of your students, instruct them to get the tool, and
stamp two or three buttons and bows on Hermit Crab's shell as in
the example.

w
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18. Next, they will click on the Alphabet Stamp tool and stamp a
number sentence to go with it in the box.

19. Have students stamp their names and print them out for evaluation.

20.Ask students to sign the check sheet when they are finished.

21.Hermit Crab Rebus Books a Partner Activity

22.Show students the rebus story on the Internet at
http://www.fi.edu/fellows/fellow8/dec98/rebus.html. Explain that
a rebus story contains both words and pictures.

23.Now, show students how to create their own rebus story in
KidWorks similar to the example. Follow the directions for creating
your Rebus story.

24.Assign each student a partner and have them create a story to go
with the title, "Hermit Crab's Next House". Reread the last two
pages of A House for Hermit Crab to remind students of the plans
that he was making for his new house.

25.Allow students to share their stories with the class when they are
done.

Assessment: Students will be assessed on their completed graph,

participation in the fime line activity and completed center activity.

The rebus story will be evaluated with the checklist at

(http://pblchecklist.4teachers.org/view.php3?id=1744).

Extension: Have students research for more information about the
other animals in the book. Allow them to write facts about each animal
in KidWorks.
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9.

Step by Step
Creating Word Cards in Microsoft Word

Using a Scanner, scan pictures of the characters from the book House for
Hermit Crab. Or take pictures with the digital camera. Follow the directions for
scanning based on your particular type of scanner.

Save your scanned picture on a floppy disk or your computer’s hard drive.

Open Microsoft Word.

Create the boxes for your word cards by clicking on the rectangle tool along the
bottom toolbar.

Rectangle Tool Line Thickness Tool

JD[awv ls Coj|ngt05hapesv . \DO4‘|&'gvévE_:.e,|
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Click and drag to create your rectangle. To resize it, click and drag on the
corners.

Change the line thickness using the tool at the bottom.

Import your scanned picture. Click on Insertand Picture. Then choose From File.
Locate the file on your computer’s hard drive or on the floppy disk. Click on the
name of the file, then Insert. Your graphic should now appear.

Click on the graphic to activate it and a toolbar will appear. Click on the text-
wrapping tool.

Cropping Tool Text- Wrapping Tool

H
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Choose In Front of Text. Click and drag on the corners to resize it. If you wish
to crop the picture, click on the cropping tool. Then click on the picture to select
it and click and drag on the small rectangles on each side to crop it.

10. Move your graphic into position on the word card.
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Rectangle Tool
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11. Add your text box. Click on the text box tool at the bottom of your screen.

12. Click and drag inside your box to create the text box. Type the word or letters
in the text box. To change the font, size, and style, and justification, highlight
the words and use the tool bar at the top as you would with regular text.
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13. Make the text box larger or smaller by clicking and dragging on the corners
after you have selected it.

14. You can move your text box into position by clicking and dragging the outline of
the text box.

15. Erase the line that surrounds the text box, click on the line color tool at the
bottom tool bar. Select No Line at the top of that window.

Line Color Tool

|§_|‘?r l
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Step by Step
Hermit Crab Time Line with Time Liner 4.0

Hanit Hanit Hepia Fepia Hepia Hepi Hepia Ty e Hanit Hanic Hanic
azblet ab sa safsh aram agd s vet aleda (€:=9) Gebhed Gebnet
s farda aewe alis hs afis udin trath rterf hita gom asvk
ad v ahs sd sd dd atis afoet shto v ad azbad
vetto sd sd sd d gt aard resdel ket tim
lockfor sevesl trer s aute noein
asv vay dd v teret

sd nuth

Jaay Femary March Al My Jwe Jy Age Spenba Qe Noenter Decentor

1. Openup Timeliner 4.0.

2. Click on New.

3. Click on Floating.

4. Click to select monthly/yearly, and double-click on the word monthly before
clicking OK.

5. Enter the word January in the When column. Press the fab key.

6. Enter the sentence "Hermit Crab left his shell and went to look for a new one.”

Press return.
7. Continue to enter information until your data table looks like the one below.

" & File Edit View Format Toolbox Help 338PM [ | € )
O0=———————— HermitCrab timelineE"reaeasi——-r———————— N5

= =5 When What
L & January Hermit crab left his shell and went to look for a new one.
e = & February | Hermit crab found a new shell.
s L & March He put a sea anemane on his shell.

L& April He put a starfish on his shell.
L& May He put a coral on his shell.
L & June He put a snail on his shell.
L& July He put a sea urchin on his shell,
L & August They went through a forest of seaweed.
L & September He asked a lanternfish to light their way.
L & October Hermit Crab built a wall around his shell.
L & MNovember Hermit Crab had grown and needed another new shell.
‘£ =& December Hermit Crab met a smaller crab and let him move in the next month.

8. Click on View and Banner. Click on Compress or Expand to make your timeline
shorter or longer.
9. Click on the event and click on the black box to the right to size your flag.
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10. Click on the event to drag it up or down.

11. Click on the event and the shaded bar on the left side of the flag to choose a
style for your flag.

12.Click on Edit and New Title to add a title to your time line.

13. Import graphics if desired by copying from another program and pasting onto
your time line.
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Software Helper
TimeLiner 5.0

TimelLiner is a practical, easy-to-use tool for creating and printing time lines that
show historical, contemporary, and future events. With TimelLiner you can
construct banner time lines that wrap around your classroom, poster-size time lines
for a bulletin board, or single-page time lines for reference and review.

Creating a New Time Line
Once you've launched TimelLiner, click New on the Title Screen. There are six ftime lines
from which to choose: Standard, Yearly/Monthly, Weekly, Daily, Geologic, and Custom.

e Standard Time Lines are the typical

chronological time lines. The time of |iiialkssills

an event can be as general as 1500, Standard

or as specific as 4:32 AM, March 5, [l S tme nesrs

1957. & Weekly: Events may be as general as
o Yearly/Monthly Time Lines, such as C Sy B P varcn 1861,

a school year, are not anchored to O Zeolozle e sz 1963 1oes

any particular year. They can be a o Custom:

year long, or a month long.

e Weekly Time Lines such as a weekly schedule are not set in any particular week.
These time lines represent events that occur regularly on certain days of the
week.

e Daily Time Lines, such as a class schedule, are not set on any particular day.
These time lines show what occurs regularly at certain ftimes of the day.

e Geologic Time Lines can range from 100 billion years ago to the present. You can
also prefix a year with a plus sign to indicate dates in the future.

e Custom Time Lines present non-time based data such as temperature, distance, or
percent.

Data View Compact View Slideshow View

The Five Views of TimeLiner

There are five different ways to view
your time line. Click on the appropriate E -EE'E
button at the top of the screen to . E E
change your view.

Banner View List View
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Data View- This view shows all of your data at all times, even if some events are hidden
in other views. This is the place to go for an overview of all of your time line
information.

Banner View- Create and print time lines from 1-100 pages long.

Compact View- Create and print time lines that range from one page to a multi-
page poster.

List View- Create a vertical list of the events in your timeline.

Slideshow View- Create a slideshow of your fime line in which every event becomes a
slide. This view is most useful if you have attached media elements to your events.

Using the Zoom Buttons

Banner time lines can be viewed in three sizes: 100%, 50%, and 25%. To o0 %

change the view size, click on the icons in the lower left corner.

The Clock Tools

The tools that you will need in all views are located in the toolbar under the clock.
These tools are New Event, Delete, Edit, Graphic, Label, Expand, Compress, Merge, and
Print.

e New Event- Click on the New Event button on the clock toolbar.
Type the date and name of the event. Click OK to add this event
to the time line. When adding new events, you may see a default
date already entered in the When box. If the new event is
different from the default date, simply type the new date over the
highlighted default date. If you are entering a range of dates, you
can use both of the fields next to When. If you only want to
enter one date, click on the fo button to remove the ending date
field. You can enter now or present as a date and the current date
will appear.

IT
IT
=

]
(]

il

1

0 Category- This allows you to assign a specific category to your
events. You can add your own categories as well.
o Notes- You can add more information about the specific event.
These notes can be viewed in the Slideshow View or can be viewed as a link
in Banner view. The notes cannot be printed.
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o0 Picture or Movie- You can add a picture or movie saved on your computer’s
hard drive or you can choose from one of TimelLiner's movies and graphics.
These pictures and movies can be viewed in the Slideshow View or as a link
in Banner view. The pictures and movies will not appear when printing.

0 Sound- You can add sound that has been saved on your computer's hard
drive or you can choose from one of TimeLiner's sounds.

0 Web Links- You can create a link to a web site using this tab.

o Delete- Click on the event or flag, and then on the De/ete button under the
clock. If you delete an event from one view, it erases it in every view.

o Edit- Click on the event or flag, and then on the Edit button under the clock.
Make the needed changes and click OK.

e Graphic-To add a graphic from TimelLiner's clip-art gallery, click on the
Graphic button and then choose your art. Click OK when ready. To import a
saved graphic from your computer, click on Browse and locate the file from
your computer's hard drive. Then click Open. Click on the graphic and drag
it into position. Click and drag the red squares at the corner of the graphic
to resize it.

e Label- To add a heading or title for your time line, click on Label.
Type a heading and click OK. You can now click on the heading and
drag it into position. To change the font of your label, select it and
click on the Choose Font button at the top of the screen. To edit Cﬁgﬁfe
the label, simply double-click.

e Expand and Compress- Click on the Expand and Compress buttons to shorten
or lengthen your time line.

e Merge-You can use this feature to merge your time line with other standard
time lines created with TimelLiner.

e Print-This enables you to print the current - Hamy 8. Triman %
view of your time line. You can customize = -
your printed time line by adding a border. 2 R §
Click on Page Setup to change the orientation Anne's Samrie
of your page. If you don't want to print the

1 = B

entire banner, you can enter specific pages o
: . - e Cop ot
when you click the Print button. canger| [ PNk page seup |
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Hiding and Including Dates

You can hide events in one view without deleting the events from other view. Click on
the event and choose Hide Event from the Format menu. The event will now be invisible
and will not print from within this view. To see the event again, click on Format and
Include Event. You will see a dialog window that lists all of the hidden events.

Adjusting the Number of Pages

With larger time lines, expanding and compressing sometimes increases or decreases
the length of the time line in large chunks. You can easily adjust your time line to be a
specific length. You can see the number of pages in your time line at the bottom of your
screen. Click on the number of the last page and then type the number of pages that
you wish to have. The time line will reformat fo include the specified amount of pages.

Customizing an Event's Font, Color, and Style

You can use different fonts, sizes, styles, and colors to highlight different events and
show relationships between events. A quick way to group many events at once is to
assign them a category and assign the category a unique font and style. Once you have
selected your event, click on £dit and Choose Event Font.

Changing the Flag Style

Changing the flag style is another way to customize events and highlight
relationships between different types of events. Each flag can have a

different shape, flag color, text color, or fill color. To change the style of an et Flog
event flag, select the flag you wish to change. Then click the Edit Flag Style Style

button at the top of the screen. The Flag Style Dialog window
will appear, allowing you to customize the shape and color of ”IZ' °F=© ; —
YOUI" ﬂGg Text Color Im

Outline Color I Il Black 'I
Fill Color | (] white  =|

Changing the Flag Size imsre]  concel | O

To resize a flag, click on the red rectangle to the right of a
selected flag and drag it info position.
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Adding the Date fo Text 3
The Add Date to Text feature automatically adds the [°F% Ry

date of each event into the event flag. Click Format | © e I Par new oventa detout 1 BC
. ¥ Hour
and Add Date to Text. If you select this feature, you | =M
. o ) . ol Dy siie s - Sample
will only see it in the current view. To add it to each 7 Show AD 1830 Saturday, February 15, 1689

view, you must select it independently.
Cancel

72 A=

Customizing the Time Scale T
The time scale is the bottom axis of the Banner time line or the top of a Edit Time
Compact time line. You can change the color, size, font, and style of the Scale

time scale. Click on the fime scale to select it and click the Edit Time

Scale button at the top of the screen. This will open a dialog window that allows you to
change the thickness and color. Click on the Choose Font button to change the font of
your text.

Formatting the Date

You can set way that you want the date to appear on your time line by clicking on Format
and Date Format. This will open a dialog window in which you can set how you wish the
date to appear.

Taking a Snapshot of your Banner

In the Banner View, you can take a snapshot of your time line by clicking on File and
Export Banner View as Graphic. A pull-down list allows you to copy the entire view or
save the image in a different file format to use as a graphic in another application. This
feature only works for time lines that are 3 pages wide or smaller. This will allow you to
create a graphic of your time line that can be pasted into a paint program, word
processor, or desktop publishing program.

Changing Symbols in the List View

In the List View, each event begins with a small symbol. Different symbols
can be used to highlight different types of events and to show the
relationships between events. To choose a symbol, select an event, and
then click on the Edit Symbo/ Style button. You will get a pop-up dialog Edit Symbol

box in which you can select a different symbol. If you want to select more Style
than one event at a time, press the shift key down while you click to select
events.
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El==Cl-1-

The When and What Columns in Data View

The When column shows the specific date of an event or the \
starting and ending dates. To show both dates, click on Slideshow
Format and Event Range. The When column will become the View

Start column and an £End column will be added. The What

column is where you enter the information for an event. As you enter information,
pressing Return or Enter when on the last line of the Data View always gives you a blank
line. You can also add new events by clicking on the New Event button under the clock.

The Category Column in Data View

You can add a category column by clicking on Format and Categories. This helps you
organize and group events in your time line.

Selecting a Row in Data View

To the left of the Start column is a narrow column of gray rectangles. Double-click on a
rectangle next to an event to select it and edit the contents of that row.

Viewing your Time Line as a Slideshow

Click on the Slideshow View icon at the top of the screen to switch to the
Slideshow View.

Setting up Your Slideshow

The Slideshow setup lets you customize your slideshow.

e Slide Transitions (Macintosh version)- This changes B2 S
the transition effects that appear between slides .
during a slideshow.

¢ Background- Change the background color or pattern
that appears around the slides during a show.

e Auto-Play Sounds and Movies- Check this box if you
want sound and movies to play automatically when a
slide is displayed.

e Auto-Advance- Check this box and type a number to
set the amount of time that each slide will display.
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e Only show Events with Media Attachments- Check this box to show only slides
with media attachments such as sounds, pictures, movies, notes, or Web links.

e Loop- Check this box to cycle through the slides again and again without returning
to the Slideshow Setup screen. Press the ESC key to exit the slideshow.

Presenting Your Slideshow

To advance to the next slide, click the Next button in the lower right corner of the
screen. To return to a previous slide, click Back in the lower left corner of the screen.
Press the £5Ckey at any time to exit the slideshow.

Printing a Slideshow

Click on File and Print from the Slideshow Setup screen. Each slide will print on one
page. This is the only way fo print notes that are attached to events.
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Habitats Lesson Plan

Notes

Instruction
Essential Questions for Teachers:
How can I use specific internet sites that my students can use to
research a fopic for a writing activity?

Essential Question: What are some of the various water habitats
and what are their characteristics.

Learning Goals:

Describe the basic requirements for all living things to maintain their
existence. ( Key concepts: Needs of life-food, habitat, water,
shelter, air, light, minerals. Rea/-world contexts: Selected
ecosystems, such as an aquarium, rotting log, terrarium, backyard,
local pond or wetland, wood lot.)

Integrate listening, speaking, viewing, reading, and writing skills for
multiple purposes and in varied contexts. Examples include using more
than one of the language arts to create a story, write a poem or
letter, or fo prepare and present a unit project on their community.

Materials: Student reproducibles, word processing software,
handouts and notes from previous lesson. Reference CD-Roms,
reference material, reproducibles.

Technology Connections: Internet connection

Procedures

e Explore a habitat whole group using the internet site
http://mbgnet.mobot.org/MBGnet/sets/index.htm, and
other reference material. Include a variety of pictures
and videos so young children may obtain a visual image of
the habitat.

e Keep a chart in the room of characteristics of the habitat,
as well as plants and animals native to that habitat.

e Students will use a storyboard to write and illustrate
interesting facts about the habitat. Illustrations should
portray animals and plants of the habitat. Stories should
be shared with a friend, revised and edited as needed.
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e The finished project may be published using Storybook
Weaver Deluxe, Microsoft Photo Story or KidPix.

Assessment:
Student research portfolio and published report will be assessed.

Related URLs:
http://library.advanced.org/11922/habitats/habitats.htm
http://mbgnet.mobot.org/MBGnet/sets/index.htm
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Habitat Adventure Fact Gathering Sheet
Habitats Facts about Habitat Animals
Habitat #1
Habitat#2
Habitat #3
Habitat #4
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Habitat Adventure Story Development

Your story is of a great adventure! You will pick an animal we have
researched and use it as the main character of your story.

My animal/character (main character):

Characteristics of my main character:

My character is in search of:

Now let's start the creative process. Remember we are blending facts
about habitats and a fictional story about an adventure.
Habitat #1

Habitat: Habitat character(s):

What is the main character looking | Story points: (Key points you want to
for here? What conflicts does express. May include facts about
he/she encounter? How are they the habitat.)

resolved or not?
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Habitat #2

Habitat:

Habitat character(s):

What is the main character looking
for here? What conflicts does
he/she encounter? How are they
resolved or not?

Story points: (Key points you want to
express. May include facts about
the habitat.)

Habitat #3

Habitat:

Habitat character(s):

What is the main character looking
for here? What conflicts does
he/she encounter? How are they
resolved or not?

Story points: (Key points you want to
express. May include facts about
the habitat.)
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Habitat #4

Habitat:

Habitat character(s):

What is the main character looking
for here? What conflicts does
he/she encounter? How are they
resolved or not?

Story points: (Key points you want to
express. May include facts about
the habitat.)
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Adventure Storyboard

Now lets pull it all together. Combine the information you have gathered
to create the various parts of your story.

o
Intro/Slide 1 ' o)
Text:
Background/6Graphics
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Slide 2
Text:

Background/6Graphics
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Student Self-Assessment

Name
Date

Peer Editor Project

Color the smiley if you completed each direction.

&) I wrote sentences about my habitat.

@ T used pictures and phonetic spelling.
T used correct spelling of words I know how to spell.
I completed a storyboard.

I checked for correct use of capital letters and punctuation.

© 0 © O

I included a detailed illustration of my habitat, including plants and animals.
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Assessment

Name Date

@ You wrote sentences about your habitat.

@ You used pictures and phonetic spelling.

@ You used correct spelling of words you know how to spell.

@ You completed a storyboard.

@ You checked for correct use of capital letters and punctuation.

@ You included a detailed illustration of your habitat, including plants and
animals.
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Notes
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